
FFExplorer 
TUTORIAL 

 

Dieses Tutorial stellt einen Überblick über FFExplorer v12.6, nachfolgend FFE genannt, dar. Mit Hilfe dieser 

Information wird man lernen wie diese Anwendung benutzt wird, aber um die besten Ergebnisse zu 

erzielen, wird eine Grundidee für fraktale Geometrie benötigt. 

 

 

 

 

« Being a language, mathematics may be used not only to inform but also, among 

other things, to seduce... » 

Benoît Mandelbrot, creator of the Theory of Fractals 

 

fractalfun.es/en. 

 

 

 

 

 

 

http://www.fractalfun.es/en
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EIN FRAKTAL ERKUNDEN 

Man öffnet ein neues Projekt mit „File“ / „New canvas“  oder der Tastenkombination „Strg + N“ . Wenn 

man einen speziellen Fraktaltyp öffnen will, mit der Maustaste über „New canvas of type“ gehen und 

danach den gewünschten Typ des Fraktals im Untermenü auswählen. 

Um ein Fraktal zu erkunden kann man folgendermaßen vorgehen: 

• HINEIN ZOOMEN 
Mit der linken Maustaste einen Punkt auf der Abbildung setzen und mit der gedrückten 

Maustaste eine Fläche markieren. Wenn die Maustaste losgelassen wird zoomt man automatisch 

in die ausgewählte Stelle. Mehr Möglichkeiten zum Thema zoomen findet man im Menüpunkt 

„Hilfe“ unter „Exploring guide“ von EEF. 

 

• HERAUS ZOOMEN 
Mit der rechten Maustaste auf einen Punkt im Bild gehen. Mit gedrückter Maustaste eine Fläche 

markieren, Maustaste loslassen und es wird aus der Fläche herausgezoomt. 
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• ZENTRIEREN 
Es gibt dafür drei Möglichkeiten: 

1. Auf einen Punkt im Bild doppelklicken um es zu zentrieren. 

2. Auf einen Punkt im Bild klicken, während „F“ gedrückt wird. 

3. Scrollrad der Maus gedrückt halten und eine Fläche im Bild markieren. Scrollrad loslassen 

und die Mitte der ausgewählten Fläche wird zentriert. 

 

• SCROLLEN 

Es gibt dafür zwei Möglichkeiten: 

1. Die Umschalttaste gedrückt halten, während man mit der linken Maustaste einen 

Ursprungspunkt festlegt. Ohne die Tasten loszulassen, den Mauszeiger zum Zielpunkt 

führen. Die Maustaste loslassen um den Scroll vom Ursprung zum Ziel zu bestätigen. 

 

2. Die „Strg” Taste gedrückt halten, während man mit der linken Maustaste auf einen Punkt 

über dem Bild geht um ihn „einzufangen“. Ohne die Tasten loszulassen, den Mauszeiger 

ziehen, um das Bild in eine neue Position zu ziehen. Die Maustaste loslassen um den 

Bildscroll in der neuen Position zu bestätigen. 
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• DREHEN 

* Drehen ist nicht möglich bei den speziellen Fraktalen Bifurcation und IFS. 

Es gibt zwei Möglichkeiten zu drehen: 

1. Die Umschalttaste gedrückt halten, während mit der rechten Maustaste ein Punkt in das 

Bild gemacht wird um das Rotationszentrum festzulegen. Ohne beide Tasten loszulassen, 

den Mauszeiger horizontal bewegen um das Bild zu drehen. Die Maustaste loslassen um 

das rotierte Bild zu fixieren. 

 

2. Die Strg-Taste gedrückt halten, während mit der linken Maustaste auf einen beliebigen 

Punkt geklickt wird. Ohne beide Tasten loszulássen, die Maus horizontal bewegen um das 

Bild um den Mittelpunkt zu drehen. Die Maustaste loslassen um das Bild zu fixieren. 
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Diese Art zu drehen kann genauer ausgeführt werden, wenn man im Punkt „Edit“ 

arbeitet, aber dazu kommen wir später. 

• GRÖßE ANPASSEN 

Ändert man die Größe des Fensters passt sich das Bild automatisch an. Während man das 

ausführt wird die Bildgröße im Fenster angezeigt. 

 

Man kann zusätzlich die Größe des Bildes mit „Canvas size“ und „Canvas aspect ratio“ anpassen, 

die man unter dem Menüpunkt „Window“ findet. 

• SATELLITE VIEW 

Klickt man auf „Satellite View“ im Menü „Edit“ oder „Strg + Pfeil nach oben“ kann man aus dem 

Fraktal heraus zoomen und das gesamte Fraktal betrachten. Der Mittelpunkt des ursprünglichen 

Bildes bleibt zentriert. 

 

• MAIN VIEW 

Auf „Main View“ im Menü „Edit“ klicken oder „Strg + Leertaste“ um eine komplette Übersicht 

über das Fraktal zu erhalten. Dabei geht der Mittelpunkt des Originalbildes verloren. 
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Alle Punkte die eine Auswahl mit der Maus beinhalten, werden, wenn sie beendet werden, den 

Mittelpunkt des ausgewählten Teilbildes in die Mitte des Bildes setzen. Dies kann mit der   „Esc - Taste“ 

rückgängig gemacht werden, bevor die Maustaste losgelassen wird. 

Weitere Tips... 

Um die Bilder schneller zu zeigen, wird empfohlen kleinere Bildausschnitte zum Erforschen auszuwählen 

und zur Originalgröße zurückzukehren, bevor das finale Bild erzeugt wird. 

Um ungewollte Rahmenänderungen durch Größenänderung zu vermeiden muss man das Verhalten der 

Ansicht, das man am Ende haben möchte, berücksichtigen, z.B. wenn man ein Bild mit 1600 x 1000 Pixel 

erzeugen möchte, wird empfohlen mit einem kleineren Bild proportional zu arbeiten. d.h. Das 

Ansichtsverhältnis das man wünscht ist 1600 x 1000 = 1,6 , um Größenverhältnisprobleme zu vermeiden, 

z.b. 320 x 200 Pixel. 

Wenn man ein neues Bild öffnet ohne den Typ des Fraktals speziell zu wählen, wird der zuletzt 

verwendete Typ geöffnet.  

 

ÄNDERN DES FRAKTALTYPS 

Öffnen des Tools „Parameter“ im Menü „View“ oder man verwendet die Tastenkombination „Strg + Alt + 

P“. Dieses Tool hat für jeden Fraktaltyp einen Reiter (Zone 1 auf der Abbildung) mit den dazugehörigen 

Parametern (Zone 2 auf der Abbildung) und einen Abschnitt von gewöhnlichen Parametern für alle 

Fraktale (Zone 3 in der Abbildung). Wähle aus den verschiedenen Reitern, um den Fraktaltyp zu ändern. 

FFE Version 12.6 beinhaltet folgende Fraktale : Mandelbrot, Phoenix, Burning Ship, Lambda, Magnet, 

Spider, Manowar, Nova, IRF (Newton, Halley, Secant, Householder, Schröder, Steffensen, Laguerre, 

Muller, Parhalley Whittaker und Chebyshev), Fatou, Collatz, Mandelbox 2D, Lyapunov, Bifurcation, IFS, 

Buddhabrot und Linear. Diese Hauptfunktionen ermöglichen es bis zu 220 verschiedene Fraktaltypen zu 

erzeugen. 

There is also the possibility of creating custom formulas, as it will be seen later. 

Mandelbox 2D, Lyapunov, Bifurcation, IFS, Buddhabrot und Linear sind spezielle Fraktale und einige in 

diesem Tutorial beschriebene Funktionen können bei diesen nicht angewendet werden. 
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Wenn mehrere leere Leinwände geöffnet sind, zeigt dieses Tool die Parameter, der „Active canvas“, der 

zuletzt geöffneten Leinwand. Dies trifft auch auf andere Tools zu, wie man später sehen wird. Die „Active 

canvas“ wird mit einem pfeilförmigen Icon angezeigt. 

 

Weitere Tipps... 

Jede Leinwand hat eine unabhängige Historie für die Änderungen jedes Fraktaltyps, so dass, wenn zu 

einem anderen Typ gewechselt wird, die Information der Historie nicht verloren geht. Man kann die 

Historie der Veränderungen benutzen, indem man im Menü „Edit“ auf „Undo“ und „Redo“ klickt, oder 

„Strg + Z“ oder „Strg + Y“ klickt. 

1 

2 

3 
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Wenn man ein Fraktal erforscht, kann es vorkommen, dass sich das Icon „Active canvas“, orange färbt. 

Dies bedeutet, dass der Computer momentan ausgelastet ist. 

 

DIE PARAMETER EINER FUNKTION VERÄNDERN 

Jedes Fraktal wird aus einem Algorithmus heraus erzeugt. Dieser Algorithmus hat spezielle Parameter die 

verändert werden können. Öffne das Menü „View“ oder drücke „Strg + Alt + P“ und verändere die Werte 

um Variationen im Originalfraktal zu erzeugen. Klicke auf „Apply“ im Parameterfeld um die Änderungen 

zu übernehmen. 

 

Die gewöhnlichen Parameter aller Fraktale sind (Zone 1 in der Abbildung): 

• NUMBER OF ITERATIONS (positive Ganzzahl) 
Dies zeigt an wie oft die Funktion neu berechnet wird. Ein hoher Wert gibt dem Fraktal mehr Tiefe 

um hinein zoomen zu können, verlangsamt aber die Berechnung. Die Wiederholungen sollten nur 

bei Bedarf schrittweise erhöht werden. 

• CENTRAL COORDINATES (komplexe Zahlen) 

Dieser Parameter erlaubt es einen bestimmten Punkt des Fraktals innerhalb des Ursprungsbildes 

mit Hilfe der Koordinaten zu zentrieren. Wenn man das Fraktal erkundet, ändert sich dieser Wert 

mit den Koordinaten des Punktes im Fraktal, der mit dem Zentrum des Ursprungsbildes 

korrespondiert. 

1 
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• ZOOM (positive decimal number) 

This parameter allows positive or negative zooming on the central coordinates. When exploring 

the fractal, this value changes with the zoom level. 

To locate an area of the fractal in FFE, the "Central coordinates" and "Zoom" parameters must be 

used together. Also, it may be necessary to adjust the "Number of iterations". The zoom level can 

be provided in scientific notation, and in that case, to enter it in the “parameters” form, it is 

necessary to transform it as follows: 

Scientific notation E notation Value 

123.456789 x 104 

123.456789 x 10-4 

123.456789E4 

123.456789E-4 

1234567.89 

0.0123456789 

 

For example, the following parameters correspond to the location of an elephant, from the Valley 

of the Elephants, from the Mandelbrot set: 

Central coordinates: 0.276507227815727, -0.00652125825352444 i 

Zoom: x 12836.3610205248 

Die spezifischen Parameter des Fraktaltyps sind: 

• EXPONENT OF Z (Dezimalzahl) 
* Dieser Parameter kann für die speziellen Fraktale nicht verändert werden. 

Dies ist der Exponent der Variablen Z und erlaubt Mutationen in den Originalfraktalen zu 

erzeugen. 

• JULIA'S CONSTANT (komplexe Zahl) 

Wenn man diesen Parameter aktiviert, wird die Variable „C“ so verändert, dass diese mit dem 

Satzwert konstant wird und das Fraktal durch die „Julia Methode“ gezeichnet wird. 

Wenn dies deaktiviert ist, wird dieser Wert nicht verwendet und das Fraktal geht in die 

ursprüngliche Form, die Aktivierung durch die „Mandelbrot-Methode“, zurück. In diesem Fall 

ändert sich, wenn man das Fraktal erkundet, der vorgegebene Wert für „C“ im Verhältnis zu den 

Koordinaten des Bildmittelpunktes. 

• DISTORTION CONSTANT (komplexe Zahl) 

Diese Konstante verzerrt die Ansicht des Fraktals. Ist der Wert 0 hat er keinen Effekt. 

• RELAXATION CONSTANT (komplexe Zahl) 

Diese Konstante passt die Komplexität des Fraktals an. Ist dieser Wert 1 hat er keinen Effekt. 

• INITIAL VALUE OF Z (komplexe Zahl) 

Der Wert der Variablen „Z“ wird benützt, um die Funktion zu wiederholen und er erlaubt 

Veränderungen im Originalfraktal zu erzeugen. 
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• INITIAL VALUE OF X (Dezimalzahl) 

Dieser Wert der Variablen „X“ wird verwendet, um Wiederholungen der Funktion zu starten und 

er erlaubt Veränderungen im Originalfraktal zu erzeugen. 

• BAILOUT / TOLERANCE (positive Dezimal) 

Sein Wert setzt einen kritischen Abbruch, der, wenn er zutrifft, den Wiederholungsprozess 

unterbricht. 

• SCALE / RADIUS * / LAYER Z (Dezimalzahl) 

Dieser Parameter verändert die Größe und Erscheinung des Multifraktals. 

• LYAPUNOV’S SEQUENCE (binäre Sequenz) 

Ist eine Sequenz der Werte 0 und 1, die den Wert bestimmt, der für die Wiederherstellung der 

Funktion benutzt wird. 

• PLANE 

This option applies transformations that affect the variable that traverse the plane and allows you 

to create variants of the fractal. 

Weitere Tipps... 

Komplexe Zahlen haben einen echten Teil und einen fiktiven Teil und werden als „Z=(a+b i)“ dargestellt, 

wobei „a“ die echte Zahl und „b“ die fiktive Zahl darstellt, ein vielfaches der fiktiven Einheit „i“. Die Zahlen 

„a“ und „b“ können positive oder negative Dezimalzahlen sein und die Einheit „i“ ist eine Konstante die 

der Quadratwurzel aus -1 gleicht.  

Um den Berechnungsvorgang zu optimieren wird empfohlen die Anzahl der Wiederholungen nur wenn 

nötig zu erhöhen. Zum Beispiel sollte man sie Schrittweise erhöhen, wenn man hinein zoomt, oder 

verringern wenn man heraus zoomt. 

Wenn die Parameter eines Fraktals modifiziert werden, kann es sein, dass sich die Farbe des Icons „Active 

canvas“ verändert und blau wird. Dies bedeuted, dass einige Parameter noch bearbeitet werden. 
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CREATE CUSTOM FORMULAS 

To add new formulas, the syntax of the Visual Basic programming language must be used, of which the 

application recognizes the Math class and the Complex data structure. 

FFE allows you to create formulas that will take advantage of all the features of the fractal and colouring 

algorithms available in the application. To do this, open the formula editor from the “View” menu or by 

pressing “Alt + O”. 

 

This tool allows you to customize the formula by following these steps:  

1. DEFINITION OF VARIABLES 

In this step, all the variables that will be used in the formula must be defined, which can be of the 

following types: 

https://docs.microsoft.com/en-us/dotnet/api/system.math?view=netframework-4.7.2
https://docs.microsoft.com/en-us/dotnet/api/system.numerics.complex?view=netframework-4.7.2


 

 

13 FF Explorer v12.6 - Tutorial Ins Deutsche übersetzt von Dagmar Hamedinger 

13 

 

• Iteration: variable to iterate. This is the variable whose value will be used to colour the 

analysed pixel after its iteration process. In the parameters form, its initial value can be 

modified. (Maximum: 1 variable) 

• Pixel: variable to traverse the plane. This is the variable that the algorithm will use to 

store the coordinates of the complex plane that it is going to analyse at all times, and that 

correspond to the pixel to be coloured. (Maximum: 1 variable) 

• Value: auxiliary variable. This is a variable that can be used for different purposes. For 

example, as a constant value or to store the result of an operation whose value you want 

to use multiple times later. (Maximum: not established) 

2. PREVIOUS OPERATIONS (optional) 

In this step you can define operations before to the iteration process. For example: 

• Calculation of mirror plane “C + = 1 / C”, where “C” is the variable of type “pixel”. 

• Inverse plane calculation “C = 1 / C”, where “C” is the “pixel” type variable. 

Although you can force the inverse plane in this way, it is a good idea not to do it and let 

the application try to do it itself when the “Invert” option is activated in the parameters 

form. 

• Julia mode “Z = P”, where “Z” is the variable of type “iteration” and “P” is the variable of 

type “pixel”. Although “Julia mode” can be forced in this way, it is a good idea not to do it 

and let the application try to do it itself when the “Julia’s constant” is activated in the 

parameters form. 

At this point it is also possible to initialize variables of type “Value” with the values of other 

variables whose type can only be used once. For example: “V = C”, where “V” is a variable of type 

“Value” and “C” is the variable of type “pixel”. 

3. BAILOUT CONDITIONS 

In this step, the conditions that, if produced, will make the iteration process end before the 

iterations entered in the parameter form have been consumed, will be defined. Conditions can be 

of the following types: 

• Bailout: it will be given when the absolute value of the chosen variable exceeds the value 

of the bailout entered. 

• Tolerance: will be given when the absolute value of the chosen variable is less than or 

equal to the tolerance value entered. 

In the parameters form, the values of “Bailout” and “Tolerance” can be modified. 

4. ITERATION LOOP OPERATIONS 

In this step, the operations of the iteration loop will be defined, that is, the operations that 

correspond to the iterative function of the fractal. 



 

 

14 FF Explorer v12.6 - Tutorial Ins Deutsche übersetzt von Dagmar Hamedinger 

14 

 

5. FOLLOWING OPERATIONS (optional) 

In this step you can define operations after to the iteration process. 

6. COMMENTS (optional) 

In this section you can add any useful information related to the formula or its author. 

To finish, enter the name with which you want to save the formula, a class name for its grouping 

(optional) and then press one of the following buttons (depending on the desired action): 

• Apply, to save and change the active canvas formula to the new one. 

• Open, to save and open a new canvas that uses the formula. 

• Save, to save the formula. 

If the formula is compiled correctly, it will become available along with the rest of the algorithms built 

into the application. In the event of compilation errors, an informational message will appear and the 

errors will need to be fixed before the formula can be used. 

When the active canvas displays a fractal calculated with a formula of the editor, the editor will offer the 

possibility to add a representative image of the fractal to the formula. To do this, explore the fractal, 

check the “Current formula” box and press the “Include example” or “Update example” button. Then 

press the “Save” button to overwrite the formula.  

To open a canvas with the example formula, click on its preview. 

Not recommended Recommended 

V = New Complex(2, 0) 

PI = 2 * Math.Asin(1) 

PHI = (Math.Sqrt(5) + 1) / 2 

V = 2 

PI = Math.PI 

PHI = 1.6180339887498949 

 

Sample formulas can be loaded into the formula editor from the file menu, by positioning the mouse 

cursor on "Open example formula" and choosing the desired formula example. 

 

 

 

 

 

 

 

 



 

 

15 FF Explorer v12.6 - Tutorial Ins Deutsche übersetzt von Dagmar Hamedinger 

15 

 

VERÄNDERN DER FARBGEBUNGSMETHODE 

* Die speziellen Fraktale benützen spezifische Farbgebungsmethoden, die nicht verändert werden 

können. 

Um ein Fraktal zeichnen zu können ist es notwendig, eine Farbgebungsmethode zu definieren. FFE nützt 

den „Escape Time“ Algorithmus als Standard. Um eine andere Methode zu benützen, klickt man auf das 

Menü „Settings“ und hält den Mauszeiger auf „Colouring Method by default“. Klicke auf die Methode im 

Untermenü, um sie als Standard zu verwenden. 

FFE hat folgende Farbgebungsmethoden: 

• ESCAPE TIME: Es färbt das Bild anhand der Anzahl der Wiederholungen, die während der 

Berechnung erreicht wurden. 

 

This colouring method allows you to use shapes and supershapes to define the escape perimeter: 

 

• ESCAPE ANGLE: Färbt das Bild währed der Berechnung in Abhängigkeit zum Winkel zwischen der 

Variablen, die für die Wiederholungen genommen wurde undder horizontalen Achse. It allows to 

choose from different reference angles. It also allows to represent the phase portrait of the 

fractal, which will not be affected by the configured escape radius and will provide better results 

in fractals with few iterations. 
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• DISTANCE TO A POINT: it colours the image according to the closest distance to a point reached 

by a variable used during the calculation process. It allows to choose from different geometric 

shapes and customized shapes to represent the distance. 

 

All the colouring methods described above allow the possibility of smooth the sudden changes of colour, 

except in the special case of colouration by escape time with shape or supershape. To activate this option 

by default, click on the menu "Settings" and then on "Activate smoothed colouring by default". 

 

 
Smooth Escape Time colouring. 

Escape Time colouring. 

 

All the colouring methods admits an illumination effect based on slope. To activate this option by default, 

click on the menu "Settings" and then on "Activate illuminated colouring by default". 

 



 

 

17 FF Explorer v12.6 - Tutorial Ins Deutsche übersetzt von Dagmar Hamedinger 

17 

 

 
Illuminated Escape Time colouring. 

Smooth Escape Time colouring. 

 

* Fractals that use the bailout offer better results in smoothing and illumination with a high bailout. 

Man kann die Farbgebungsmethode für ein spezielles Ursprungsbild ändern, indem man auf das 

Hinweissymbol „Colouring“ in  „Edit“ klickt. Dies lässt sich unter dem Menü „View“ öffnen oder mit der 

Tastenkombination „Strg + Alt + E“, dort gibt es auch erweiterte Einstellungen zum Anwenden: 

• To obtain a preview of the coloring of the “Active Canvas” and to be able to modify its 

parameters, check the “Current method” box. 

• Use the lighting controls to change the color, angle and height of the spotlight. This last feature 

will make the shadows sharper and longer or softer and shorter. 

“Juliter” colouring will only be available when the active canvas has the “Juliter Transformation” applied, 

this colouring mode will make only the iterations consumed during the transformation calculation be used 

to colouring, not the previous ones. 
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ANWENDUNG UND VERWALTEN VON PALETTEN 

* Jedes Fraktal steht in Verbindung mit seiner eignen vorgegebene Palette, ausser den speziellen 

Fraktalen Lyapunov, Bifurcation, IFS, Buddhabrot und Mandelbox 2D in der X-Ray Version. Um die Farben 

der beiden vorhergehenden Fraktale zu verändern verwendet man „Colour in“ (Zone 1 in der Abbildung) 

und für das dritte verwendet man die Option „Last iteration in...“ aus der „Options“-Vorlage (zu finden 

unter „Special options“). 

Um unterschiedliche Paletten zu verwenden, klickt man auf „Edit“ und geht mit dem Mauszeiger auf 

„Apply palette“. Man klickt auf die Art der Palette im gezeigten Untermenü, die man verwenden möchte, 

und danach ebenfalls auf der Palette. Diese Option ist ebenfalls unter dem Hinweissymbol „Palettes“ 

unter „Edit“ zu finden, das im Menü „View“ öffnen kann, oder mit der Tastenkombination „Strg + Alt + E“, 

wo man auch erweiterte Einstellungen finden kann: 

• Prüfe die „Current palette“ um eine Vorschau auf die „Active canvas“ zu bekommen oder die 

Anzahl der Farben anzuzeigen. 

• Um die Farben der Palette zu scrollen, kann man mit der linken Maustaste auf Vorschau klicken 

und den Mauszeiger drüber gleiten lassen. Man kann den Scrollwert unter der Vorschau sehen. 

Dann klickt man auf „Apply“. 

 

Special options: 

• LAST ITERATION IN... / COLOUR IN... 

Diese Option benützt eine bestimmte Farbe um während der Berechnung der letzten 

Wiederholung zu zeichnen. Um diese zu aktivieren muss man das Dialogfeld prüfen oder man 

wählt eine Farbe im Auswahlbereich. If the type of palette is “External”, and it has at least 256 

1 
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colours, it will habilitate the possibility of using the first colour for the last iteration, eliminating it 

form the palette. 

Diese Farbe ist in den Spezialfraktalen Bifurcation, Lyapunov und Buddhabrot bereits eingestellt. 

• LAST ITERATION OVER ORBIT TRAP  

Diese Option zeichnet den Bereich der die letzte Wiederholung der Formel betrifft über das Orbit 

Trap. 

Um Paletten zu verwalten hat man folgende Funktionen: 

• PALETTEN IMPORTIEREN 

In der Anwendung sind vorgegebene Paletten importiert, aber es gibt die Möglichkeit neue 

Paletten hinzuzufügen. Dies kann man unter „File“ „Import palettes“ machen. In dem Dialogfeld 

das sich öffnet kann man eine oder mehrere Paletten Dateien mit den Endungen F2C (external 

palette), F2CC (customized palette) o F2ZC (palettes package), auswählen und anschließend auf 

„Open“ klicken. 

Die neuen Paletten werden in den Ordner „Paletten“ kopiert. 

• PALETTEN LÖSCHEN 

Man klickt auf „File“ und fährt mit dem Mauszeiger auf „Delete Palette“, dann klickt man auf die 

Art der Palette die man löschen möchte im angezeigten Untermenü, und danach ebenfalls auf die 

Palette. 

Die vorinstallierten Paletten sind mit einem Sternchen markiert und können nicht gelöscht 

werden. Diese sind: 

1. Random B&W: graue Farbtöne wechseln zufällig jedes mal wenn sie verwendet wird. 

2. Random RGB: die Farben wechseln zufällig bei jeder Anwendung. 

3. Random R: die roten Farbtöne wechseln zufällig. 

4. Random G: die grünen Farbtöne wechseln zufällig. 

5. Random B: die blauen Farbtöne wechseln zufällig. 

6. Rainbow: Zerfall der weißen Farbe in Regenbogenfarben. 

7. Striped: vorgegebene Paletten in diesen Fraktaltypen: Magnet, Spider, Manowar, 

Newton, Halley, Secant, Householder, Schröder, Steffensen, Laguerre, Whittaker, Fatou, 

Collatz, zufällige Julias und Mandelbox 2D. 

8. Striped-Legacy: previous version of the palette Striped. 

9. Continuous: vorgegebene Palette in diesem Fraktaltyp: Mandelbrot, Phoenix, Burning 

Ship, Lambda und Nova. 

10. Continuous-Legacy: previous version of the palette Continuous. 
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11. Editor: temporäre Palette aus dem “Customized palettes editor”. 

12. B.Default: vorgegebene Palette in Verbindung mit dem Fraktaltyp ist tatsächlich 

„Gestreift“ oder „Fortlaufend“. 

Die Option die Paletten zu verwalten besteht ebenfalls unter „File“ welches sich unter Menü „View“ 

öffnet, oder mit der Tastenkombination „Strg + Alt + F“. 

 

Weitere Tipps... 

Palettendateien können ebenfalls per „drag and drop“ in die Arbeitsfläche von FFE importiert werden. 

In den meisten Paletten ist die erste Farbe normalerweise schwarz. Der Grund dafür ist, wenn ein Fraktal 

berechnet wird, dass mit einer Anzahl von Wiederholungen die Anzahl der Farben einer Palette 

vervielfältigt wird. Es werden die Punkte dieser letzten Wiederholung der Funktion entsprechend, immer 

schwarz gezeichnet. 
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ERZEUGEN VON INDIVIDUELLEN PALETTEN 

Öffne den “Customized palettes editor” im Menü “View” oder verwende die Tastenkombination “Alt + I”. 

 

Dieses Tool ist in zwei Teile geteilt: 

• FARBEN EDITOR (ZONE 1 DES BILDES) 
Dieser ermöglicht es einen Verlaf von 1024 Farben aus einem Muster aus maximal 16 und minimal 

2Hauptfarben zu erzeugen. Ein Vorerzeugtes Muster kann aus dem Meü “Theme” geladen 

werden, oder kann indiviualisiert werden, indme man auf die Farben klickt um diese zu ändern. 

Um einem Muster mehr Farben hinzuzufügen, klickt man auf den Verlauf über der Position in der 

man etwas hinzufügen möchte.Möchte man Farben entfernen, klickt man auf den 

entsprechenden Bereich der Farben (über dem Verlauf) doppelt. Um die Bereiche zu Verschieben, 

klickt man diese mit der linken Maustaste an, hält diese gedrückt und verschiebt die markierten 

Teile an den gewünschten Ort im Verlauf. 

• PALETTEN GENERATOR (ZONE 2 DES BILDES) 
Ermöglicht eine 1024 Farben Palette (maximum) aus dem zuvor erstellten Verlauf zu 

erzeugen.Dazu muss man die Anzahl der Farebn, die man verwenden möchte festlegen. Diese 

dann benennen und abspeichern mit  „Save”.  

Die Option „Try as...“ kann verwendet werden um eine Palette anzusehen bevor sie abgespeichert 

wird. Allerdings muss diese danach noch gespeichert werden, um aus der temporären Palette 

eine beständige zu machen und sicher zu gehen, dass das Image seine Ansicht behält. 

 

 

1 
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VERWENDEN UND VERWALTEN VON ORBIT TRAPS UND PATTERNS (MUSTERN) 

* Orbit Traps sind für die speziellen Fraktale nicht verfügbar. 

The “Orbit trap” is a special colouring method based on a pattern to be adapted to the fractal. FFE 12.6 

version includes 78 built-in shapes, the option to create customized shapes and an image’s pattern 

function. With all this the next types of orbit traps can be applied: 

• NONE: ist der Standardtyp und wird verwendet um ein Orbit Trap zu unterdrücken. Das Fraktal 

wird mit der Colouring Methode gezeichnet wenn dies als Standard im Bild verwendet wird. 

• SHAPE: es verwendet eine vorinstallierte Form um das Fraktal zu zeichnen. 

• SUPERSHAPE: uses a customized shape using a formula to draw the fractal. 

• PATTERN: dieses Trap benutzt eine Bilddatei als Muster und ist die einzige, die nicht auf Paletten 

basiert. 

• MULTIPLE: es verwendet diverse vorinstallierte Formen customized und/oder Patterns gleichzeitig 

um das Fraktal zu zeichnen. 

Um ein einfaches „Orbit trap“ zu verwenden klickt man auch „Edit“ in der Menüleiste und geht mit dem 

Mauszeiger auf „Apply Orbit trap“. Klicke im angezeigten Untermenü auf den gewünschten Pattern-Typ 

den du verwenden möchtest. Diese Option ist ebenfalls unter den Symbol „Orbit Trap“ im Dialogfeld 

„Edit“ ,das sich unter dem Menü „View“ öffnet, verfügbar, oder mit der Tastenkombination „Strg + Alt + 

E“, von wo man ebenfalls die Möglichkeit hat aus anderen Typen von Orbit Traps auszuwählen und die 

Mustereigenschaften zu verändern (Zone 1 in der Abbildung): 

• Um eine Vorschau des „Active canvas“ Orbit trap zu erhalten, kann man den Haken bei  „Current 

trap“ setzen. 

• Um das Orbit trap zu scrollen, klickt man mit der linken Maustaste auf die Vorschau und bewegt 

den Mauszeiger. Man kann den Scrollwert unter der Vorschau sehen. Dann auf „Apply“ klicken 

(„Add“ oder „Replace“ wenn das Orbit trap „Multiple“ ist). 

• Um den Rest der Orbit trap Eigenschaften zu ändern, kann man deren Werte mit den anpassen 

Reglern verändern und dann auf „Apply“ („Add“ oder „Replace“ wenn das Orbit trap „Multiple“ 

ist). 

Eine FFE Eigenschaft, die erwähnt werden sollte, ist, dass FFE es ermöglicht die anpassen Regler zu 

konfigurieren um ein genaueres Anpassen der Parameter zu ermöglichen. Dies kann man machen, indem 

man einen extra Regler verwendet, der es ermöglicht eine spezielle Dezimalposition auszuwählen, die 

man verändern möchte (Zone 2 in der Abbildung). 
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Wenn das gewählte Orbit trap „Multiple“ ist, werden die Muster im „Multiple trap“ editor hinzugefügt, 

oder ersetzt wo sie als Ganzes verwaltet und angewandt werden kann. 

1 

2 
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Es gibt Unterschiede zwischen dem „Simple“ orbit trap (1) und dem „Multiple“ Orbit trap, das nur mit 

einem Muster erzeugt wird (2) wenn die Deckkraft nicht maximal ist. Das Erste verschmilzt mit dem 

Überlappenden und das zweite lässt es durchscheinen. Zusätzlich gibt es die Möglichkeit die Farbe der 

Paletten für das „Multiple trap“ aufzuspalten (3). 

 

_2_  _1_  _3_  
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To design customized shapes, read the section “Create customized shapes”. 

Um Muster zu verwalten hat man folgende Funktionen: 

• MUSTER IMPORTIEREN 

Es gibt vorgegebene Patterns, die in der Anwendung vorinstalliert sind, aber es gibt die 

Möglichkeit neue Muster hinzuzufügen. Um das zu tun, klickt man auf „Import Patterns“ im Menü 

„File“. Im Dialogfeld das sich öffnet, wählt man eine, oder mehrere Bilddateien mit den Endungen 

PNG, BMP oder JPG aus, und klickt auf „Open“. 

Die neuen Muster werden in den Ordner „Patterns“ der Anwendung kopiert. 

• MUSTER LÖSCHEN 

Auf „File“ klicken und mit dem Mauszeiger auf „Delete pattern“ gehen. Auf das Muster im 

Untermenü klicken, das man löschen möchte. 

Die Vorinstallierten Muster wurden mit einem Sternchen markiert und können nicht gelöscht 

werden. 

Die Optionen Muster zu verwalten sind ebenfalls unter „View“ „File“ zu finden oder mit der 

Tastenkombination „Strg + Alt + F“. 

 

Weitere Tipps... 

Um ein individuelles Orbit trap zu erzeugen kann man ein PNG Bild mit transparentem Hintergrund 

erstellen und als Muster importieren. Wenn dieses Muster verwendet wird, wird das Fraktal mit diesem 

Bild gezeichnet, und die transparenten Bereiche lassen sehen was darunter ist. 
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Der Zeichenvorgang passt das Muster an die Fraktalform an, indem er es faltet und streckt. Das Ergebnis 

wird verfälscht, wenn das Muster eine schlechte Qualität hat. Um dies zu vermeiden, sollten nur Muster 

mit hoher Auflösung verwendet werden, die es ermöglichen auch tiefer hinein zu zoomen ohne die 

Qualität zu schnell zu mindern. 

Musterdateien können auch per „drag and drop“ in die FFE Arbeitsfläche importiert werden. 

 

EIN FRAKTAL DREHEN 

* Rotation ist nicht möglich für die Spezialfraktale Bifurcation und IFS. 

Um die Fraktalrotation einzurichten, geht man im Menü „Edit“ mit dem Mauszeiger auf „Rotate“. Man 

klickt auf die Rotation um Untermenü, die man verwenden möchte. 

 

Diese Option gibt es ebenfalls unter dem „Orbit Trap“ Symbol unter „Edit“, welches unter „View“ geöffnet 

werden kann, oder mit der Tastenkombination „Strg + Alt + E“: 

• Um die Rotation des „Active canvas“ zu sehen kann man in das Feld „Current Rotation“ schauen. 

• Um den Winkel anzupassen, kann man mit der linken Maustaste auf Vorschau klicken und den 

Mauszeiger bewegen. Man kann den Scrollwert unter der Vorschau sehen. Dann auf „Apply“ 

klicken. 

• Um die Bild Rotation zu entfernen, drückt man die Schaltfläche "R" und danach "Apply". 

• Um den Winkel noch genauer anzupassen, kann man den Regler benutzen und dann auf „Apply 

rotation“ klicken. 
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CREATE CUSTOMIZED SHAPES 

* Customized shapes are not available for special fractals.  

FFE has a customized shapes editor based on “Super Formula” to create shapes that can be used in 

distance colouring and as an orbital trap. 

Open the superformula editor from the “View” menu or by pressing “Alt + F”. 
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The “Display Area” checkbox shows a shadow under the shape which can be useful for displaying annular 

shapes in the preview. 

The “Display recommended scale” checkbox shows a frame in which it is recommended to fit the shape 

before saving it. 

Adjust the parameters of the superformula to create the customized shape, enter a name and finally 

press the “Save” button. The customized shape will be available for use in distance-based colouring and 

as an orbit trap. 

To manage customized shapes you have the following functions: 

• IMPORT SUPERFORMULAS 

Application has a built-in superformula, but there is a possibility to add new superformulas. To do 

this, click on “Import superformulas” in “File” menu. In the dialog box that opens, select one or 

more superformula files, with extension F2S or F2SZ, and click on “Open”. 
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The new superformulas are copied in the superformulas folder of the application. 

• DELETE SUPERFORMULAS 

Click on “File” menu and hold the pointer on “Delete superformula”. Click on the superformula 

you want to delete in the displayed submenu. 

The built-in superformulas are shown up with an asterisk and they cannot be deleted. 

The options of superformulas management are also available in the form “File”, which opens from “View” 

menu, or pressing “Ctrl + Alt + F”. 

 

Learn more… 

The superformula is a generalization in polar coordinates of the superelipse formula. Many examples can 

be found on the Internet that show the values of the parameters required to obtain known shapes. You 

can make “Superformula” work like “Superelipse” using the values A, B, M1 = M2 = 4 and N1 = N2 = N3. 

More information here. 

 

USING THE ELEMENTS SELECTOR 

Some of the tools seen above have access to the “Element picker” for ease of use. From the "Element 

picker" you can choose palettes, themes, orbit traps, shapes, superformulas and formulas depending on 

the type of tool and the action being performed on it. Once the element is chosen in the selector, it will 

be set in the tool and could be used from it. 

https://www.fractalfun.es/superformula.php?i=en
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It should be noted that the "Element picker" will display different subsets of the element type, depending 

on the tool's configuration at any given time. 

For example, to choose an orbit trap, open the “Edit” form, select the “Orbit trap” tab, and choose a 

subset of traps (shape, supershape, or pattern). Next, double-click on the orbit trap preview to bring up 

the selector. In the selector, enter a filter to find specific elements more easily and double click on the 

desired element. The element will be set in the tool and could be used from there. 
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Next it is how to open the “Element picker” for different types of elements: 

 

Element type Selector access 

Palette for base colouring Edit form, “Palette” tab: double click on the main palette preview. 

Orbit trap colouring palette Edit form, “Orbit trap” tab: double click the orbital trap palette 

preview. 

Shape for the perimeter of the 

scape radius 

Edit form, “Colouring” tab, “Escape” mode: double click on the 

colouration preview. 

Shape for base colouration Edit form, “Colouring” tab, “Distance” mode: double click on the 

colouration preview. 

Orbit trap Edit form, “Orbit trap” tab: double click on the orbit trap preview. 

Superformula Superformula editor: double click on the superformula preview. 

Colour theme Customized palettes editor: double click on the palette preview. 

Formula Formula editor: double click the preview of the formula example. 
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EINSTELLUNGSMÖGLICHKEITEN 

Öffne unter „View“ das Menü „Options“ oder drücke „Strg + Alt + O“ . Dieses Feld hat einen Bereich von 

Optionen, die nur verändert werden können, wenn das „Active canvas“ sich nicht gerade in der 

Berechnung befindet (Zone 1 in der Abbildung) und einen anderen mit Optionen die jederzeit verändert 

werden können ( Zone 2 in der Abbildung). 

 

Folgende Optionen außerhalb des Berechnungsprozesses sind vorhanden: 

• ACTIVATE ANTI-ALIASING FILTER WITH GRILLE… 

* Anti-Aliasing Filter ist nicht vorhanden in den Spezialfraktalen Bifurcation, IFS und Buddhabrot. 

„Anti-Aliasing“ ist eine Methode, die es ermöglicht Bilder mit höherer Qualität zu erhalten, am 

ähnlichsten dem Fraktal, das zusätzliche Farbeinsätze verwendet. Diese Zeichenmethode erhöht 

die Bearbeitungszeit, somit wird empfohlen dies ausgeschaltet zu lassen und erst für das 

endgültige Bild, das danach abgespeichert wird, zu verwenden. Um es zu aktivieren, muss man  

einen Haken setzen, oder man wählt die Gittergröße (Grille) im Combo-Feld. 

Man kann den „Anit-Aliasing-Filter“ punktuell in einem Bild anwenden, ohne diese Option 

freizuschalten. Um dies zu machen muss man in der Menüleiste „View“ öffnen und den „Anti-

aliasing filter“ öffnen, oder man drückt „Strg + Alt + A“. Wähle die Gittergröße und klicke auf 

„Apply“. 

Die immer vorhandenen Optionen sind: 

• ACTIVATE FAST SCROLLING 

* Schnelles Scrollen ist nicht für die Spezialfraktale vorhanden. 

Wenn man das Fraktal mit der Maus scrollt, wird das vorherige Bild beliebig benutzt um das neue 

Bild nicht vollständig neu zu berechnen. Bevor man das Bild nach dem  schnellen scrollen 

1 
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speichert, wird empfohlen, dieses nochmal zu berechnen indem man „F5“ drückt, um einen „anti-

aliasing filter“ anzuwenden. Die Leinwand,, bei der diese Option aktiv ist, wird mit einem 

pfeilförmigen Icon zusammen mit zwei weißen Linien markiert. 

• ACTIVATE MOUSE FREE SCROLLING 

This option makes that, when doing any movement with the mouse upon the image, the 

operation is not compromised if the pointer gets the screen’s limits. 

• SHOW FRAMING GUIDES - HALVES 

This option shows up some guidelines dividing the width and length of the canvas in halves in 

order to improve de framing when making any operation with the mouse over the image. 

• SHOW FRAMING GUIDES - THIRDS 

This option shows up some guidelines dividing the width and length in thirds in order to improve 

the framing when making any operation with the mouse over the image. 

• SHOW FRAMING GUIDES - GOLDEN PROPORTIONS 

This option shows up some guidelines representing the golden proportions in order to improve 

the framing when making any operation with the mouse over the image. 

• SHOW FRAMING GUIDES - MAXIMUM CIRCLE 

This option shows up a guideline representing the maximum circle in order to improve the 

framing when making any operation with the mouse over the image. 

• SHOW FRAMING GUIDES - THIRD CIRCLE 

This option shows up a guideline representing the circle equal in size to one third in order to 

improve the framing when making any operation with the mouse over the image. 

• SAVE IMAGE CHANGES AUTOMATICALLY 

Diese Option speichert automatisch jedes mal das Fraktal, wenn es verändert wurde. Das Bild 

wird als PNG Datei im Bildordner der Anwendung innerhalb einse Bild Unterordners, in dem diese 

Option freigegeben ist, gespeichert. Man kann den Bildordner des „Active canvas“ unter „File“ 

öffnen, indem man auf „Open images folder of the canvas“ klickt, oder die Tastenkombination 

„Strg + Shift (Umschalttaste) + O“ benutzt ( dieser Ordner wird erzeugt sobald das erste Bild 

gespeichert wird). 

• ACTIVATE PARALLEL COMPUTATION 

This option takes full advantage of the processor's capabilities to calculate images more quickly. 

• ACTIVATE IMAGE REFRESHING (Legacy) 

Diese Option aktualisiert das Bild fortschreitend während der Berechnung. Es wird empfohlen 

diese Funktion auszuschalten, weil sie den Berechnungsprozess verlangsamt. This option is 

retained for its usefulness in some cases, but prevents multiple threads and parallel computation 

from being used to compute images more quickly. 

Weitere Tipps... 

Die Bilder, die eine hohe Anzahl verschiedener Farben auf kleiner Fläche enthalten, verbessern ihre 

Qualität, wenn man den “Anti-Aliasing Filter“ mit einer hohen Gittergröße verwendet. Für Bilder mit 
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großen Flächen derselben Farbe, genügt eine geringe Gittergröße. Es wird empfohlen damit zu 

experimentieren, um zu lernen welche Gittergröße passend zum Typ des Bildes ist, denn in manchen 

Fällen verlangsamen hohe Gittergrößen den Berechnungsprozess ohne viel Änderung als kleinere zu 

bringen. 

Die Option „Save image changes automatically“ kann zusammen mit einer Funktion, die, z.B. Film-Frames 

erzeugt, zum Erstellen von Videos oder Animationen verwendet werden, indem man eine externe 

Anwendung benützt. 

Die Option „Activate fast scrolling“ kann als Standard für alle Vorlagen im Menü „Settings“ aktiviert 

werden. Bevor das Bild nach dem schnellen Scrollen gespeichert wird, wird empfohlen noch einmal neu 

zu berechnen, indem man „F5“ drückt, oder den „anti-aliasing filter“ anwendet. 

 

MIT POINTS ARBEITEN 

Ein wichtiges Feature von FFE ist, dass man einen Schnappschuss von allen Parametern und 

Konfigurationen, die man zum Zeichnen eines Fraktals jederzeit benötigt, machen kann. Diese Information 

wird in einer Datei innerhalb der Anwendung, die es ermöglicht das Bild jederzeit wieder herzustellen, 

hinterlegt. 

Während diese läuft, merkt sich FFE eine Liste der letzten 30 Points, zusammenhängend mit 

geschlossenen Vorlagen. Dies ermöglicht  es einen früher verworfenen Point wiederherzustellen, wenn 

dieser nicht bereits wieder überschrieben ist. 

Um diese Points zu verwalten, gibt es folgende Funktionen: 

• EINEN POINT ANLEGEN 

Man klickt auf „Register Point“ im Menü „File“ oder nutzt die Tastenkombination „Strg + R“. In 

dem Fenster das sich öffnet schreibt man einen Namen für den Point, und man schreibt einen 

Kommentar (optional) und überprüft das „Send“ Fenster (wie unten beschrieben), falls 

gewünscht. Danach klickt man auf „Register“. 

• EINEN POINT LADEN 

Man klickt im Menü auf  „File“ und geht mit dem Mauszeiger auf „Load point“. Im angezeigten 

Untermenü klickt man auf den gewünschten Point. 

• EINEN POINT UMBENENNEN 

Man klickt auf „File“ und geht mit dem Mauszeiger auf „Rename point“. Dort klickt man im 

Untermenü auf den Point, der umbenannt werden soll. Dort schreibt man einen neuen Namen 

und klickt auf „Rename“ im geöffneten Fenster. 

• EINEN POINT LÖSCHEN 

Man klickt auf „File“ und geht mit dem Mauszeiger auf „Delete point“. Im Untermenü auf den 

Point klicken, der gelöscht werden soll. 

• EINEN POINT WIEDERHERSTELLEN 

Man klickt auf „File“ und geht mit dem Mauszeiger auf „Recover point“. Im Untermenü auf den 

Point klicken, der wiederhergestellt werden soll. 
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In den dargestellten Untermenüs mit den Namen der erstellten Points, wird, wenn man mit dem 

Mauszeiger über einen konkreten Point geht, ein Feld geöffnet, in dem der Kommentar angezeigt wird, 

der beim Erstellen eventuell eingetragen wurde.  

Alle beschriebene Optionen können ebenso im Fenster „File“ das unter dem Menü „View“  geöffnet 

werden kann, gefunden werden, oder mit der Tastenkombination „Strg + Alt + F“. 
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Weitere Tipps... 

Mit Points zu arbeiten ist die am meisten empfohlene Option, weil diese vermeidet, dass man sich alle 

benötigten Einstellungen um ein Bild zu erzeugen  merken muss, und man kann diese leicht zur 

Weiterverarbeitung in der Zukunft wiederbenützen. 

 

EXPORTIEREN UND IMPORTIEREN VON PARAMETERN 

FFE ermöglicht es Fraktals durch eine Funktion zu teilen, welche alle ihre Parameter und Konfigurationen 

exportiert. Diese Info kann von jedem FFE User angewandt werden, um den selben Fraktal zu bekommen. 

• PARAMETER EXPORTIEREN 

Man klickt auf „File“ / „Export parameters“ oder verwendet die Tastenkombination „Strg + E“.  

Man prüft, ob das Bild dessen Parameter exportiert werden sollen, in dem Fenster angezeigt wird, 

das sich öffnet, und wählt eine der folgenden Optionen: 

1. Beinhalten von Paletten und Mustern: Wenn das Bild eine Palette oder ein Muster 

verwendet, die nicht in FFE eingebettet ist, wird empfohlen diese Option anzuwenden. 

Ein Dialogfeld öffnet sich, wenn man den Button drückt, um den Pfad zum Exportieren 

der Parameterdateien auszuwählen. 

2. Nur Parameter: Diese Option wurde erstellt, um die Parameter eines Bildes, das einbaute 

Paletten und Muster verwendet, zu exportieren. Die Parameter werden beim Drücken des 

Button in „Windows-clipboard“ exportiert. 
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Die exportierten Parameter können an eine E-mail angehängt werden und an andere FFE User 

gesandt werden. Z.B. die Parameter des obigen Bildes sind folgende: 

/5uwK/mSYwymCJ0wgxb4D0j+Z+pLmRNYAnWeQAZ4N/C8nycOIltryuNy8g4MvZk+ZnfucvD4ujds

OBmCOQi3AU/aI2gOSbSCLo4hWBCnjoH9q2srYwuD0pHFBdlkeUP+ZFxWCeLbx4DHRklhvv4xT13

XkcGiFBbPNvocGteMkvuGzNlN3tWxDweEjdPDFsB1kRGkXKyxfC89sVxT9NxOF5aY0wNGuT06i0w

baFJXpcYCSRBdZztIgqQVeDZ/Ped3Tum4l2qtYdU4mo4VoeSr7+Oc+7JJrTXGZKLSoA1M6qudLbvU

npn51zsOBb2rIaPLDOvAsabRpBiWJE4prBPd2+wXib/AZk4BI01Qtrd1pcaifPTlavT1+PSc/HCQyhiG

VDiyByPW/oXxDE2B+y8KL9hEvN6xjjRQBUHhfBZqGh0btJUSPVN3pbOg+6jU8uwQWCCLQraQ2DP

oXG9I/QddFeFBQIPpRTiETzH7KD1ubKS4KAMIdSXC0CK8Y5CFeIqf17hrekTQZpycETNMsYaaNdrQ

pHRywGnpRcVw6bNcWIxFeDWEAkUFBnhOpbEJ5tMcgTppfeyc4XkdW9nW40FvdBn07sqPBCljNB

1seA35+d3xDZunovXQblGeyaGrpSgaKvhHbhYyuVDAAy60CKJuj7ooRE3JkaUOu1rjAXhtLto1Sct+E

UrbN9E6WkN/9TN8GBguI58= 

• PARAMETER IMPORTIEREN 

Man klickt  auf „Import Parameters” im Menü „File” oder benutzt die Tastenkombination „Strg + 

I“. Es gibt zwei Möglichkeiten die Parameter in dem geöffneten Fenster zu importieren: 

1. Man klickt auf „Examine“, so dass ein Dialogfenster geöffnet wird und die Datei der 

exportierten Parameter gesucht werden kann. 
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2. Man fügt die Zeilen des Parameters in das Textfeld ein und klickt auf „Import”. 

 

Das dazugehörige Bild wird in einer neuen Vorlage berechnet. 

Weitere Tipps... 

Beachte, dass, wenn man mit der Option „Only parameters“ exportiert, der vorherige Inhalt im 

„Windows-Clipboard“ verloren geht und von den parametern ersetzt wird. 

Parameterdateien können ebenfalls mit „drag and drop“ in die FFE Arbeitsfläche importiert werden. 

 

BETRACHTEN DER JULIA SETS EINES FRAKTALS 

Man öffnet unter dem Menü „View“ den „Julia Viewer“ oder man drückt „Strg + Alt + J“. Wenn die „Active 

canvas“ kompatibel ist, zeigt dieser Viewer das Julia Set. 

* Der „Julia viewer“ ist nur kompatibel mit Fraktalen, die auf der Mandelbrotmethode basieren und 

schließt die Spezialfraktale aus.  

Um die Julia Sets anzuzeigen muss man die Maus über die Vorlage bewegen. 

 

Um die Julia Sets, die im Viewer angezeigt werden, zu berechnen, muss man „J“ drücken, und über das 

Vorlagebild klicken ohne die Maus zu bewegen. 

Weitere Tipps... 

Die Mandelbrot-Zeichenmethode stellt einen Plan von allen möglichen Julia Sets dar. Julia Sets die zum 

inneren Mandelbrot gehören, sind geschlossen, während die, die zum äußeren Mandelbrot gehören offen 

sind. 
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APPLY JULITER TRANSFORMATIONS 

Open the “Juliter viewer” from the “View” menu or press “Control + Alt + U”. If the “Active canvas” is 

compatible, this viewer shows the possible transformations of the fractal. 

* The “Juliter viewer” is only compatible with fractals based on “Mandelbrot’s method”, excluding the 

special fractals.  

To view the possible Juliter Transformations, adjust the iteration number in the bottom bar and move 

your mouse over the canvas. 

 

In order to apply the transformation that is showed in the viewer press “U” key and click over the canvas 

without moving the mouse. 

Learn more… 

The “Juliter Transformation” arises during the development of new functionalities for FFE, and as a test of 

the hypothesis that fractals can be represented with an adjustable mixture between the Mandelbrot and 

Julia methods. More information here. 

 

 

 

 

 

 

 

 

 

 

https://www.fractalfun.es/juliter.php?i=en
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JULIA MAPS ERZEUGEN 

* Maps für Julia sind für die Spezialfraktale nicht vorhanden und gehören nur zu Fraktalen, die auf der 

Mandelbrot Methode basieren. 

Man öffnet unter „View“ / „Maps of Julia designer“ oder man verwendet die Tastenkombination „Alt + 

M“. 

 

(Das Fenster „Fit Julias“ zentriert und passt jedes Julia in seine Zelle ein) 

Man passt die Anzahlt der Zellen an und drückt „Start“. Wenn der Prozess abgeschlossen ist, speichert 

man das erzeugte Bild ab. 

Weitere Tipps... 

Julia Maps werden aus Julia Sets gemacht, die passend geordnet wurden, sodass ein Plan gezeigt wird, der 

einem Plan gleicht, der die Mandelbrotmethode enthält. 

 

LINEARE FRAKTALE ERZEUGEN 

FFE ermöglicht es lineare Fraktale aus einem Patter zu erzeugen, das eine Gruppe von Points verbindet, 

die vom Benutzer festgelegt werden. Dazu wird das ganze Muster wiederholt und die Werte angepasst, 

sodass diese in jedes Segment des Originalpatterns passen. Dies gilt für jede Wiederholung. 
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Man öffnet den „Linear Fractals“ Designer aus dem Menüpunkt „View“ oder benutzt die 

Tastenkombination „Alt + L“. Das Tool öffnet sich im Fullscreen-Modus, d.h. FFE maximiert sich und das 

Menü „Linear“ zeigt sich so, dass alle Designer Funktionen erreichbar sind. 

 

Hier die verschiedenen vorhandenen Funktionen: 

• LADEN EINES VORGEFERTIGTEN PATTERNS 

Hier öffnet man die Beispiel Patterns, die in der Software unter den verschiedenen Kategorien 

enthalten sind und sich im Untermenü zeigen, wenn man darauf klickt. 

• HINZUFÜGEN VON POINT „X“ VON 8 

Hier können maximal 8 Points hinzugefügt werden. Jeder neue Punkt erscheint in der Mitte der 

Zeichenebene, von dort kann man ihn mit der Maus verschieben.Dafür bitte mit dem Mauszeiger 

über den Point gehen und ihn mit der linken Maustaste fassen, wenn sich der Curser in eine Hand 

verändert.Dann verschieben und die Maustaste wieder loslassen, wenn der Zielort erreicht 

ist.Ebenso kann man neue Points hinzufügen, wenn man auf einen frieen Platz ohne Points klickt. 

• LÖSCHEN EINES POINTS VON „X“ 

Hiermit kann man den letzten gesetzten Point löschen. Es kann auch jeder existierende Point in 

der Zeichenebene durch anklicken gelöscht werden. 

• GITTER ANZEIGEN 

Ermöglicht das Hilfsgitter anzuzeigen oder zu verbergen. Dabei wird die Hintergrundfarbe 

verdeckt, wenn das Hilfsgitter sichtbar ist. 

• POINTS AM HILFSGITTER FIXIEREN 

Diese Option richtet die Points am Hilfsgitter aus. Wenn deren Position mit der Maus verändert 

wird. 
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• ALLE WIEDERHOLUNGEN ZEICHNEN 

Die Linien, die zu jeder Wiederholung im Fraktal gehören, werden angezeigt, wenn man diese 

Option wählt und sie können mit den Farbpaletten eingefärbt werden.Wird der Haken entfernt, 

wird nur die letzte Linie angezeigt.D.h. das Fraktal Image wird nur aus einer Linie und einer Farbe 

bestehen. 

• INVERT 

This option causes the fractal to generate inversely. 

• HINTERGRUND FÄRBEN IN… 

Hier kann man den Hintergrund aus vorgegebenen oder eigenen Farben wählen. Die 

Hintergrundfarbe ist nicht sichtbar, wenn das Hilfsgitter aktiv ist. 

• DIE LINIEN FÄRBEN IN… 

Hier kann man die Farbe der Linien des Fraktals aus vorgegebenen oder eigenen Farben wählen. 

• WIEDERHOLUNGEN MIT DER PALETTE FÄRBEN… 

Diese Option ist nur zur Verfügung, wenn der Hakenbei „Draw all then iterations“ gesetzt ist,und 

ermöglicht die Verwendung von Farbpaletten um die einzelnen Wiederholungen im Fraktal 

individuell zu färben. 

• DAS IMAGE BERECHNEN 

Wenn das Pattern mindestens 3 Punte hat, kann dieser Befehl das Berechnen des Faktal Images 

anstoßen. Klickt man mit der rechten Maustaste auf einen Punt in der Zeichenebene kann man 

das ebenso. Unabhängig davon wird die Imageberechnung immer automatisch 5 Sekunden 

nachdem die letzte Änderung der Parameter erfolgte angestoßen. 

• STOPPEN DER BERECHNUNG 

Während das Image Berechnet wird, kann man den Vorgang mit diesem Befhel oder mit drücken 

der „ESC –Taste“ unterbrechen. 

• ZEICHENFLÄCHE LEEREN 

Mit diesem Befehl wird jedes Muster oder Fraktalimage in der Zeichenfläche gelöscht. Durch 

drücken der mittleren Maustaste kann ebenfalls die Zeichenfläche geleert weden. 

• CALCULATE THE FRACTAL DIMENSION (square box) 

It calculates the fractal dimension using the Minkowski-Bouligand box-counting method. It will 

only be available when the “Draw all iterations” option is not being used. 

• CALCULATE THE FRACTAL DIMENSION (aspect ratio) 

It calculates the fractal dimension using a variant of the Minkowski-Bouligand box-counting 

method that uses box dimensions proportional to the image dimensions. It will only be available 

when the “Draw all iterations” option is not being used. 

• IMAGE SICHERN 

Dieser Befehl ermöglicht das Sichern der verschiedenen Grafik Componenten im Image Format 

unter der Option, die erscheint wenn auf das Untermenü geklickt wird. Z.B. kann ein Fraktal und 

sein Hintergrund gespeichert werden indem man im Untermenü auf „Background + fractal“ klickt. 
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ERZEUGEN VON CELLULAR NOISE 

Um Cellular Noise zu erzeugen, lokalisiert, FFE zufällig ein Reihe von Points und wendet das „Voronoi 

diagram“ an, um die ganze Ebene zu färben. 

Man öffnet den Cellular Noise designer im Menü „View“ oder mit der Tastenkombination „Alt + C“. 

 

Um den Zeichenprozess zu bestimmen: 

• Wähle einen der vorhandnen „cell distribution modes“: random, beehive or grid. 

1 
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• Wählt man die Anzahl der Points die man verwenden möchte. 

• Passt man die Distanz im Bezug auf die Berechnung an. Der Wert 1 ist die Distanz zu dem weitest 

entfernten Point und die Vielecke werden mit mehr Genauigkeit gezeichnet. 

• Wählt man eine der verfügbaren Farbgebungsmethoden: 

1. Um eine einzelne Farbe zu verwenden setze einen Haken in „Colour“ und wähle diese. 

2. Um eine Palette zu benutzen, entferne den oben erwähnten Haken und wähle eine 

Palette im Dialogfenster. 

Zum Schluss wählt man das Verhältnis  und die gewünschte Größe  des endgültigen Bildes ( Zone 1 in der 

Abbildung) und  klickt auf den „Start“-Button. 

Während der Berechnung und wenn diese beendet ist, können die Farben umgekehrt werden.  Um dies 

zu tun, muss man auf den Button „Invert“ klicken. 

Das Bild kann nach Beenden des Prozesse abgespeichert werden. 

 

STEREOGRAPHISCHE PROJEKTIONEN ERZEUGEN 

* Die Stereographische Projektion ist nicht erhältlich in den Spezialfraktalen Bifurcation, IFS und 

Buddhabrot. 

Um die Projektion zu zeichnen, platziert FFE eine Riemann Sphäre auf das Fraktal und berechnet dann, 

wie es auf die Oberfläche reflektiert wird. 

Man öffnet den „Riemann Sphere“ designer unter Menü „View“ oder benutzt die Tastenkombination „Alt 

+ R“. Die Vorschau der Sphäre wird automatisch in der „Active canvas“ gezeichnet, falls diese kompatibel 

ist.  
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Man passt die grundlegenden Optionen an: „Background“ Farben, „View“ Typ und Ausgabe-„Size“. Dann 

wählt man einen der folgenden Prozesse: 

• GENERATE IMAGES (Zone 1 in der Abbildung) 

Dieser Prozess erzeugt ein Bild mit dem Satz ausgewählter Ansichten, und einem unabhängigen 

Bild von jedem einzelnen Punkt. Um dies zu tun, überprüft man die Ansichten, die man sich 

wünscht und klickt dann auf „Start“. Die Bilder können gespeichert werden, wenn der Prozess 

abgeschlossen ist. 

• GENERATE SEQUENCE (Zone 2 in der Abbildung) 

Dieser Prozess bildet eine Sequenz von Bildern der Sphären Erhebung (zentrale Ansicht). Um dies 

zu tun, muss man folgende Parameter setzen: 

1. Initial illumination: Startpunkt für den Lichtfokus setzen. 

2. Focus spins: Anzahl der Drehungen, die den Fokus und die Richtung festlegen. 

3. Sphere spins: Anzahl der Drehungen, die die Sphäre und die Richtung festlegen. 

4. Length: Länge in Sekunden der Sequenz. 

5. FPS: Anzahl der Frames pro Sekunde. 

6. Hologram: it creates special frames to be used with a holographic pyramid. 

1 

2 
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Dann wird der „Start“-Button angeklickt. Während die Bearbeitung läuft, werden die Frames in 

den  Bildordnern der Anwendung in einem speziellen Unterordner gespeichert. Man kann den 

Bildordner nach beenden der Bearbeitungsprozesse öffnen. 

 

KALEIDOSKOPBILDER ERZEUGEN 

Man öffnet den Kaleidoskop designer im Menü „View“ oder der Tastenkombination „Alt + K“. 

 

Der Designer hat eine Fläche die es ermöglicht das Dreieck, das als Muster genommen wird, als ein 

Kaleidoskopbild zu zeichnen, und eine andere, die es ermöglicht das fertige Bild einzupassen. (Zone 1 und 

2 in der Abbildung).  

Wähle „Fractal“ um ein Kaleidoscopisches Bild vom „Active canvas“  zu erstellen, oder wähle die 

Option „Image“ um ein externes Bild zu importieren. 

Um das dreieckige Muster anzupassen: 

1 

2 

3 
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• Passt man die Größe mit dem Schieberegler „Size“ an. 

• Passt man die Position an, in dem man mit der gedrückten linken Maustaste über die Vorschau 

zieht. 

Um das endgültige Bild zu fertigen: 

• Die gewünschte Farbe mit „Tube“ einstellen. 

• Den dreieckigen Bereich bei „Divisions“ mit der gewünschten Farbe zeigen. 

Zum Schluss kann man noch das Verhältnis und die Größe, die man für das endgültige Bild gewünscht 

wird, auswählen (Zone 3 in der Abbildung) und klickt dann auf den Button „Save image“. 

Der Button „Save texture“ ermöglicht es das Grundbild zu speichern, das als Grundlage dient, um alle 

Bereiche in allen Größen abzudecken. 

 

ERZEUGEN VON DIFFUSION-LIMITED AGGREGATIONS 

Die Strukturansammlung wird durch die Freiheit eines Partikels erreicht, der zufällige Wege nimmt bis 

dieser mit etwas kollidiert das ihn stoppt. FFE ermöglicht es einen Punkt zu setzen um den die 

Strukturansammlung wachsen kann. 

Man öffnet Im Menü „View“ „Aggregation“ oder benutzt die Tastenkombination „Alt + A“. 
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Um den den Ansammlungsprozess zu starten: 

• Wähle die Option „Image“ um ein externes Bild als Urprung zu importieren. Danach kann man 

seine Position verändern, indem man mit der linken Maustaste über Vorschau geht. 

• Passt man die Größe mit dem Schieberegler „Size“ an. 

• Wählt man unter „Method“ im Dialogfenster eine verfügbare Farbgebungsmethode. 

1. BORDER: färbt das Bild in Abhängigkeit der Distanz zwischen Partikeln und den 

Bildgrenzen. 

2. SEED: färbt das Bild in Abhängigkeit der Distanz zwischen Partikeln und der 

Startpunktgrenze. 

3. MIX: das ist eine Mischung aus den beiden vorherigen Farbgebungstypen. 

1 
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• Man wählt eine verfügbare Palette aus dem Dialogfenster „Palette“. 

• Man wählt ein Verhältnis und eine gewünschte Größe für das endgültige Bild (Zone 1 in der 

Abbildung). Die Bearbeitung kann je nach ausgewählter Göße einige Zeit dauern, aber der 

„Aggregates designer“ kann geschlossen werden ohne den Vorgang zu unterbrechen. 

Dann choose DLA or Eden mode and drückt man den „Start“-Button um die Bearbeitung anzustoßen. Sie 

wird von selbst beendet, wenn alle Bildecken geschlossen sind und keine Partikel mehr eindringen 

können, aber die Hintergrundfarbe kann jederzeit ausgewählt und das Bild jederzeit abgespeichert 

werden. Um dies zu tun, setzt man den Haken bei „Background“ , wählt die Farbe und klickt dann auf den 

Button „Save image“. 
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ERZEUGEN VON SIERPINSKI DESIGNS 

Man öffnet den Sierpinski Designer  im Menü „View“ oder mit der Tastenkombination „Alt + S“. 

 

Um den Algorithmus anzustoßen passt man die Nummer der gewünschten Wiederholungen ein und wählt 

aus den vorhandenen Zeichenmodi aus: „Triangle“ oder „Carpet“. 

Um das Bild individuell anzupassen wählt man die farben aus, die man für die inneren und äusseren 

Zonen des Fraktals möchte. 

Zu Schluss wählt man noch die Größe aus, die man für das fertige Bild haben möchte und klickt dann auf 

„Save image“. 
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ERZEUGEN VON PYTHAGORAS TREE 

Man öffnet den Pythagoras Designer unter dem Menü „Vew“ oder mit der Tastenkombination „Alt + P“. 

 

Um den Algorithmusanzustoßen, muss man folgendes einstellen: 

• Passe die Anzahl der Wiederholungen an. Je größer die Anzahl der Wiederholungen, um so mehr 

Äste bekommt der Baum. 

• Passe den Wert der Variable „Angles” an. Je nachdem in welche Richtung man ihn schiebt 

wächste der Baum nach rechts oder links. 

• Passe die Stammhöhe an. Von Ihm hängt die maximale Höhe des Baumes ab. 

• Passe die Größe des Baumes an. 

• Aktiviere den „Zigzag” mode um einen sützen und zackigen Baum zu erzeugen oder setze ihn 

inaktiv um eine rundlichen Baum zu erzeugen. 

Um das Bild individuell anzupassen wählt man die Farben für die inneren und äusseren Bereiche des 

Fraktals aus. 
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Zum Schluss wählt man noch die Größe aus, die das fertige Bild haben soll und klickt dann auf „Save 

image”. 

 

MULTIPLIKATION DIAGRAMME ERZEUGEN 

Öffne den Diagramm Designer aus dem Menü „View” oder benutze die Tastenkombination „Alt + D”. 

 

Um den Zeichen Algorithmus zu setzen muss man: 

• die „Multiplier” Anzahl eingeben. 

• die „Number of operations” eingeben. 

Alle Zahlen von Null bis zur Anzahl „number of operations” werden vom Multipier vervielfältigt 

und das Ergebnis werden mit Linien im Diagramm dargestellt.  

Um die Parameter anzuwenden, nachdem die Werte eingegeben wurden, muss man „Enter” 

drücken oder „Apply” anklicken. Es kann auch variiert werdne, indem man die Abstufungen 

anpasst und die Kästchen rechts von den Parametern überprüft. 

Um das Bild zu individualisieren: 

• Wählt man die Farbe für „Outside”. Dies färbt die äußeren Bereiche. 
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• Wählt man die Fareb für „Inside”. Dies färbt die Innenseite der Umgebung. 

• Wähle die Farbe der „Marks”. Dies färbt die Perimeter der Linien und die dazugehörigen Punkte 

der Anzahl der. 

• Wählt man eine der vorhandenen Farbgebungsmethoden für die Linien: 

1. Farbe. Verwende immer die gliche Fareb für alle Linien im Diagramm. 

 

2. Palette. Verwende die Unterschiedlichen Farben in einer Palette um die Linien im 

Diagramm zu unterscheiden wie folgt: 

 

a. Produkt. Die Linienfarbe ist abhängig vom Produkt Ergebnis. 

 

b. Vervielfältiger. Die Linienfareb ist abhängig von der Vervielfältigungs Anzahl. 

Zum Schluss wählt man noch die Größe die das fertige Bild haben soll und klickt dann auf „Save image”. 

 

CREATING CELLULAR AUTOMATON 

FFE allows to create cellular automaton based on the Game of Life or rules. 

Open the “Cellular Automaton” designer from the “View” menu or by pressing “Alt + U”. This works in full 

screen mode, so FFE will be maximized to improve the experience, and the “Automaton” menu will be 

displayed to give access to all the designer functions. 

 

The different functions available in the “Automaton” menu are described below: 

• MODE 

It allows switching between the “Life” mode and the “Rule” mode, as well as establishing an initial 

layout of active cells in the automaton or changing the number of the rule in that mode. It must 



 

 

54 FF Explorer v12.6 - Tutorial Ins Deutsche übersetzt von Dagmar Hamedinger 

54 

 

be considered that for the “Ruler” mode, only the state of the first row of the grid can be 

modified. 

To manually activate or deactivate cells, click on the desired cells. You can also activate several 

cells in a row by clicking and, without releasing the button, moving the mouse. In the same way, 

but also pressing the "Shift" key, several cells can be deactivated in a row. 

• CELL SIZE 

It allows changing the size of the cell, so that for a larger size the number of cells that will make 

up the grid will be smaller, and the automaton will work at a higher speed. 

• CELL SHAPE 

Allows you to change the shape of the cell between “Square” and “Round”. 

• COLOUR THE GRID IN… 

Allows you to choose a predefined or customized colour for the grid lines. 

• COLOUR THE BACKGROUND IN… 

Allows you to choose a predefined or customized colour for the background of the grid. 

• COLOUR LIVING CELL IN… 

Allows you to choose a predefined or customized colour to represent a living cell. 

• COLOUR TRAIL IN… 

Allows you to colour the trail left by a cell with a single predefined or customized colour. The 

colour of the cell will darken over time. 

• COLOUR TRAIL WITH THE PALLETTE… 

Allows you to colour the trail left by a cell with the colours of a palette. The cell colour will go 

through the different colours in the palette over time. 

• START 

It starts the cellular automaton. It can also be started by clicking the right mouse button. 

• STOP 

When the cellular automaton is running, this command allows you to stop it. It can also be 

stopped by pressing the "Escape" key on the keyboard. 

• CLEAR 

This command allows you to remove all cells from the grid. They can also be removed by clicking 

the middle mouse button anywhere on the grid. 

• SAVE IMAGE 

This command allows you to save the current state of the cellular automaton in image format. 

• SAVE IMAGE CHANGES AUTOMATICALLY 

This command allows you to save in image format any changes that occur in the cellular 

automaton during its operation. 
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Learn more… 

When a cellular automaton relies on the state of cells in one line to generate the state of the next, as in 

"Rule" mode, it is said to be a one-dimensional automaton. Instead, when based on the state of cells 

throughout the plane, as in Conway's Game of Life, it is said to be a two-dimensional automaton. In two-

dimensional cellular automaton, the plane extends infinitely in all directions, but in FFE it has been 

decided to use a toroidally folded plane, so that complex structures that exceed the limits of the window 

on any of its sides appear by the opposite side. 

 

CREATE SNOWFLAKES 

FFE is inspired by the symmetry of the hexagonal crystalline system of ice crystals in order to create 

snowflakes. 

Open the “Snowflakes” designer from the “View” menu or by pressing “Alt + N”. 
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To create the snowflake, use the design area on the left, where you can execute the following actions: 

• ACTIVATE A BRANCH 

Click on one end of the branch. The ends of the activated branch will be colored black to identify 

it. 

• ADD A PRIMARY BRANCH 

Click the left mouse button on an empty area. The parent branch will be shown in blue. 

• ADD A SECONDARY BRANCH 

Right-click on an empty area. The child branch will be displayed in red. 

• MOVE ONE BRANCH END 

With the left mouse button, click on the desired end of a branch and, without releasing it, move 

the mouse. Release the button to confirm scrolling. 

• DELETE A BRANCH 

Double-click one of the ends of the branch. If the endpoint belongs to a child branch, only this 

branch will be deleted. If the endpoint belongs to a parent branch, this and all its child branches 

will be deleted. 

• DELETE ALL BRANCHES 

Click the middle mouse button anywhere in the design area. 

The gray area of the design area is indicative and helps to create patterns that, when replicated with 

hexagonal symmetry, do not produce unexpected branch crossings. 
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To personalize the image, choose the thickness of the line and the colors you want inside and outside the 

snowflake. 

Finally, choose the size at which you want to generate the final image and press the "Save image" button. 

 

CREATE BOIDS NETWORKS 

FFE allows you to create Boids Networks based on the Reynolds Model to observe emergent behaviours. 

Open the "Boids Networks" designer from the "View" menu or by pressing "Alt + B". 

 

To customize the simulation, use the following control groups: 

• SIMULATION 

With this control group, you can choose the type of simulation you want. 

1. Water: boids will be represented in the form of fish. 

2. Air: boids will be represented in the form of birds. 

3. Land: boids will be represented in the form of ants. 

4. Machine: boids will be represented in the form of circles. 

When positioning the mouse over the preview, informative text will appear with the parameter 

values associated with the chosen simulation type. 
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• RULES 

This control group allows you to activate or deactivate the basic rules defined by the Reynolds 

Model. 

1. Separation: boids use this rule to try to avoid colliding with each other. 

2. Alignment: boids use this rule to try to match the speed and trajectory of those around 

them. 

3. Cohesion: boids use this rule to try to belong to a group. 

Additionally, for "Air" and "Earth" simulations, a special rule specific to FFE will be available. 

1. Migration (air): this rule simulates the behaviour of migratory birds. When activated, 

under suitable conditions, "V"-shaped structures may appear, with a leading boid guiding 

the rest. 

2. Inspection (earth): this rule simulates the behaviour of ants inspecting their environment 

for food. 

• CURSOR 

This control group allows you to decide the type of reaction boids will have when encountering 

the mouse cursor. 

1. Disabled: boids will not react to the cursor. 

2. Interest: boids will show interest in the cursor and deviate from their original trajectory to 

move towards it. 

3. Obstacle: boids will try to avoid the cursor while maintaining their original trajectory as 

much as possible. 

4. Panic: boids will feel panic from the cursor and deviate from their original trajectory to 

flee from it. 

Use the "Size" control to adjust the cursor size. 

• TURBULENCE 

This control group allows you to activate an FFE-specific algorithm simulating random turbulence 

affecting the trajectory and speed of the boids. 

1. Smooth: turbulence will have a gentle effect on the movement of the boids. 

2. Strong: turbulence will have a strong effect on the movement of the boids. 

When the "Show" checkbox is activated, a "wind vane" will appear, representing the speed and 

direction of the turbulence at each moment. 

• PREY 

This control group allows you to add or remove boids of the "prey" type, as well as adjust the 

parameters of the field of vision and vision range. 

• PREDATORS 

This control group allows you to add or remove boids of the "predator" type, as well as adjust the 

parameters of the field of vision and vision range. 
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When the "Initiate Attack" checkbox is activated, “predator” boids will attack “prey” boids, 

eliminating the latter if caught. 

• AREA 

This control group allows you to activate or deactivate the boundaries of the area in which the 

boids move. 

 

When the boundaries are deactivated, boids that exceed the window boundaries on any side 

reappear on the opposite side. 

The "Clear" button removes all boids. 

• GENERAL 

This control group allows you to adjust the following general parameters of the simulation. 

1. Size: Adjusts the size of the boids. “Predator” boids will be 1.5 times larger than “prey” 

boids. 

2. Speed: Increases or decreases the speed of the boids. When the "Initiate Attack" 

checkbox is activated, the speed of “predator” boids will be slightly higher than that of 

“prey” boids. 

Press the "Start" button to begin the simulation or "Stop" to pause it. The "Reset" button restores all 

parameters to their initial values.  

Learn more... 

Deleted boids will not disappear automatically; they will be marked to leave the area when possible. 

 

AUTOMATISCHE PROZESSE MIT AUFGABEN (TASK) 

* Aufgaben sind bei den Spezialfraktalen nicht möglich. 

Man öffnet im Menü „View“ das Tool „Tasks“ oder benutzt die Tastenkombination „Strg + Alt + T“. Dieses 

Tool hat einen Registerkartenaufbau für jeden Task mit Schiebereglern und für die Parameter einen 

gewöhnlichen Bereich für alle Tasks, der es ermöglicht die Präzision der Schieberegler zu erhöhen (Zone 1 

in der Abbildung). 
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FFE Version 12.6 beinhaltet folgende Tasks: 

• ITEREATE: erhöht oder vermindert die Anzahl der Wiederholungen. 

• ZOOM: führt einen progressiven Zoom aus, positiv oder negativ. 

• ROTATE: erhöht oder vermindert den Rotationswinkel des Bildes. 

• PALETTE SCROLLING: scrollt die Farben einer Palette. 

• EXPONENT: erhöht oder vermindert den Exponenten der Variable Z. 

• INITIAL Z: erhöht oder vermindert den Anfangswert der Variable Z. 

• CENTER: scrollt das Fraktal horizontal und vertikal. 

• JULIA: verändert die  „Reale“ und „Imaginäre“ Komponente der Julia Konstante „C“. 

• DISTORTION: verändert die „Reale“ und „Imaginäre“ Komponente der Verzerrungskonstante „D“. 

1 
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• RELEXATION: verändert die „Reale“ und „Imaginäre“ Komponente der Entspannungskonstante 

„R“. 

• ORBIT TRAP OPACITY: erhöht oder vermindert die die Deckkraft des Orbit Trap. 

• ORBIT TRAP SIZE: erhöht oder vermindert die Größe des Orbit Trap. 

• ORBIT TRAP SCROLLING: scrollt das Orbit Trap. 

Nicht alle Tasks werden von allen Fraktalen unterstützt, einige von ihnen werden als „beschädigt“ 

angezeigt, abhängig vom „Active canvas“.  

Man klickt auf den „Start“-Button um die Anwendung des Task-Tools im „Active canvas“ zu aktivieren. 

Danach passt man die Parameter an und setze einen Haken in die Felder der Tasks, die man anwenden 

möchte. Dieser Vorgang verändert die Parameter zunehmend und berechnet jedes mal ein neues Bild des 

Fraktals. 

Man nimmt den Haken aus dem Feld, wenn man es stoppen möchte und klickt auf den „Stop“-Button 

wenn man das „canvas“ trennen möchte. 

Weitere Tipps... 

Das „Tasks“-Tool kann jeweils nur mit einer Leinwand verbunden werden (alle Erkundungsfunktionen 

werden während der Verbindung stillgelegt). 

Ein Task hält von selbst an, wenn irgendein Parameter unzulässige Werte  innerhalb des Fraktalstyps 

erreicht, der in der Leinwand geladen ist. 

Der „Decimal“ Regler ermöglicht es die Dezimalposition zu wählen, die in den Parameterwerten variieren, 

wenn sie durch die eigenen Schieberegler  verändert werden ( dies funktioniert nur bei  Tasks die blau 

markiert sind). 

Ein Task kann zusammen mit der Option  „Save image changes automatically“ in „Options“ verwendet 

werden, um Bilder, wie Film-Frames, zum Erstellen von Videos und Animationen zu erzeugen, indem man 

eine externe Anwendung verwendet. 
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INFORMATIONSANSICHT DES FRAKTALS 

Man öffnet das Tool „Information“ im Menü „View“ oder benutzt die Tastenkombination „Strg + Alt + I“. 

Dieses Tool zeigt die Information der betreffenden „Active canvas“. 

   

Die verfügbare Information ist folgende: 

• COORDINATES: VISIBLE AREA 

Zeigt die Koordinaten der Fläche des Fraktals, die das Bild repräsentiert. 

• COORDINATES: CENTRAL POINT 

Zeigt die Koordinaten des Punktes des Fraktals im Zusammenhang mit dem Zentrum des Bildes. 

• COORDINATES: MOUSE POINTER 

Zeigt die Koordinaten des Punktes des Fraktals im Zusammenhang mit der Mauszeigerposition. 

• DIMENSIONS: FULL SETS 

Zeigt den ungefähren Durchmesser den das komplette Fraktal haben sollte um die angezeigte 

Fläche zu zeigen. Es vergleicht zugleich diesen Wert mit der Größe des realen Objekts. 
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• DIMENSION: VISIBLE AREA 

Zeigt den ungefähren Durchmesser der Fraktalfläche der gezeigt wird. Es vergleicht zugleich 

diesen Wert mit der Größe des realen Objekts. 

• DIMENSIONS: IMAGE 

Zeigt die Druckausgabe des Bildes und sein Verhältnis. 

• ZOOM LIMIT 

Zeigt den Zoom-Level des „Active canvas“ in einem fortschreitenden Balken. Dieser sitzt über 

einem Hintergrund der seine Farbe im Verhältnis zu den drei Zoom-Leveln ändert: niedrig (grün), 

mittel (gelb) und hoch (rot). 

• ALLGEMEINE INFORMATION 

Zeigt den Fraktaltyp, die Identifikationsnummer des Fensters und den eventuellen Kommentar. 

Man kann außerdem die Formel anzeigen lassen, die während des Zeichnens auf dem „Active canvas“ 

verwendet wurde. Um dies zu tun, öffnet man den „Formulas viewer“ im Menü „View“ oder benutzt die 

Tastenkombination „Strg + Alt + R“. 

 

Weitere Tipps... 

Der „Windows-Identifier“ ermöglicht es den, zu der Leinwand gehörigen Unterordner innerhalb des 

Bildordners zu lokalisieren. 

 

DEN VORGANG PAUSIEREN 

Another important feature of FFE is that it allows closing the application at any time without losing the 

calculations made for the pending images. The next time you start the application it will display a message 

offering the possibility to view the hibernations to resume the calculations from the point they stayed by. 

To do this, choose the hibernation you wish and click on the button “Continue”. The hibernations are 

available in the “Hibernations” tab of the form “File” that opens from the “View” menu or pressing 

“Control + Alt + F”. 
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Weitere Tipps... 

Die Berechnung von einigen Bildern kann ein sehr langsamer Prozess sein abhängig von den 

Fraktaleigenschaften, der Bildgröße oder dem angewandten „Anti-aliasing filter“. In diesem Fall ist es 

nötig die Anwendung zu schließen und die Pausierung der Berechnung verhindert den Verlust der zuvor 

getanen Arbeit. 

 

HINWEISE 

Um FFE gut anwenden zu können kann man Updates der Informationen und Tipps hier holen 

www.fractalfun.es/en. 

http://www.fractalfun.es/en

